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Editing Praxis
Edius 9, Lesspain Kyno auf Maya 2018, Fusion, UE4,
Windows und Avid First Modo Retopo und mehr ... 4
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Auf Distanz - Auch wenn
der Name etwas anderes
suggeriert, lassen sich die
Animation Nodes auch fur
Standbilder einsetzen. In
diesem Beispiel wurden sie
dafur genutzt, die Objekte
in der Vitrine anhand ihrer
Entfernung zum Glas in der
Farbe zu 4ndern.
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Blender Animation Nodes 2.0

Im letzten Animation-Nodes-Artikel der Digital

Production gab es einen kleinen Ausblick auf
Version 2.0. Inzwischen ist diese erschienen

und mit Blender 2.79 gibt es eine stabile Basis.
Wer die Animation Nodes fur Motion Graphics
einsetzen will, kann sich freuen, dass mit dem
neuen Falloff-Konzept viele Arbeiten jetzt in-
tuitiver ausgefuhrt werden kénnen. AuBerdem
wurde die Performance massiv gesteigert.
von Gottfried Hofmann

oglich wurde die Leistungsstei-
Mgerung, da die Animation Nodes
unter der Haube jetzt nicht mehr
in reinem Python, sondern in Cython ge-
schrieben sind. Cython Code wird aber nicht
mehr interpretiert, sondern kompiliert. FUr
den Anwender hei3t das, dass man bei der
Installation darauf achten muss, dass man
die fUr das eigene Betriebssystem passende
Installationsdatei verwendet. Herunterladen
kann man sich die Pakete wie Ublich auf
https://github.com/JacquesLucke/anima-
tion_nodes/releases, dort stehen sie fur
Windows, Linux und Mac OS in 64-Bit-Aus-
fohrung zur Verfigung. Es geistern allerdings
noch andere Kompilate durchs Netz.
Der Zuwachs bei der Performance kann
sich durchaus sehen lassen. Nodes fUr ma-

thematische Operationen arbeiten jetzt
ca. 200-mal so schnell und einen Spitzen-
platz nimmt der Node zum Erstellen zufalliger
Vektoren ein, der gegenuber Version 1.6 eine
etwa 400-fache Geschwindigkeit aufweist.

Vektorisiert statt Schleifen

Wer sich bereits ein wenig mit den Animati-
on Nodes auseinandergesetzt hat, der wird
sich darUber freuen, dass in Version 2.0 viele
Nodes und Datentypen vektorisiert wurden.
Konkret bedeutet das, dass man mit die-
sen Nodes sowohl einzelne Datenpakete als
auch ganze Listen verarbeiten kann, ohne
dafur Schleifen bauen zu muUssen. Weniger
Schleifen heiBt auch weniger Nodes und
eine bessere Ubersicht. Und da die Schleifen

nicht abgeschafft wurden, gibt es jetzt mehr
Wege, einen gewdnschten Effekt zu errei-
chen. FUr einfache Aufgaben wird aber der
Weg Uber vektorisierte Nodes empfohlen, da
diese deutlich schneller arbeiten als manuell
erstellte Schleifen.

Falloffs

Ein weiteres neues Features in Animation
Nodes 2.0 sind die sogenannten Falloffs.
Diese funktionieren dhnlich wie die Effectors
in Cinema 4D.

Ganz abstrakt gesprochen, lassen sich
jetzt Einflussbereiche definieren, die die
Stérke von Effekten steuern kénnen. Modi-
fier in Blender lassen sich auf 8hnliche Weise
Uber Vertex Groups steuern.
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Oben: Schon wieder versteckt - Auch der Offset Matrix Node
bietet versteckte Einstellungen. Grundsatzlich ist es bei den
Animation Nodes immer eine gute Idee, rechts im Properties
Panel nach zusatzlichen Optionen Ausschau zu halten.

Rechts: Den Falloff Gber ein Objekt zu steuern, ist sehr intuitiv.
Fur die Interpolation eignet sich der Curve Interpolation Node

sehr gut.

Primitivlinge

Um das Beispiel moglichst einfach zu halten,
verwenden wir nur zwei Basis-Objekte von
Blender, sogenannte Primitives. Wir belassen
den Default Cube und fugen eine Icosphere
hinzu. An jedem Vertex der Icosphere wird
spater ein Cube platziert werden. Die Anzahl
der Vertices bestimmt also, aus wie vielen
Worfeln sich unser Objekt zusammensetzt.

Leider muss man diese Entscheidung
bei den Primitives in Blender ganz am An-
fang treffen und kann sie spater nicht mehr
3ndern. In unserem Beispiel setzen wir die
Subdivision auf 4. Dies kann man direkt nach
dem Hinzufugen eines Objekts entweder in
einem kleinen Sonderbereich im Tool Shelf
ganz unten einstellen. Falls man das Tool

Shelf gerade nicht offen hat, kann man auch
die Taste F6 drucken.

Unser erster vektorisierter Node

In diesem Beispiel kdnnen wir die Ergebnisse
der ersten Schritte leider nur indirekt sehen.
Erst nachdem wir vier Nodes zusammenge-
steckt haben, erscheinen die Frichte unserer
BemuUhungen. Zuerst fugen wir einen Object
Instancer Node hinzu (Shift+A > Object >
Instancer). Dieser erzeugt die Duplikate des
Worfels. Im Objekt-Selektor des Nodes wah-
len wir den Cube.

Jeder duplizierte Cube soll transformiert
werden. Dafur kommt der Object Matrix
Output Node gerade recht (Shift+A > Object
> Matrix Output). Die Object- und Matrix-

Links: Vorarbeit - Bis wir die Duplikate sehen kénnen, mussen
erst einmal vier Nodes hinzugefigt und richtig verschaltet wer-
den (den Get Length Node fugt Animation Nodes automatisch
hinzu). Nach dieser Vorarbeit kriegen wir aber alle Anderungen
direkt im Viewport mit.

Unten: Versteckt - Der Ausgang fir die Liste der Vertex Normals
ist standardmafig versteckt und muss erst aktiviert werden.
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Eingdnge dieses Nodes sind zu 25% trans-
parent. Das bedeutet, dass man sowohl ein-
zelne Objekte und Matrizen als auch Listen
in den Eingang stecken kann. Mit anderen
Worten: Er ist vektorisiert. Wir brauchen for
diesen Node keinen Loop.

Der Ausgang des Object Instancer Nodes
ist zu 50% transparent. Das bedeutet, es
handelt sich hierbei um eine Liste. Wenn wir
ihn mit dem Object-Eingang des Object Ma-
trix Output Nodes verbinden, so wird auch
der Ausgang des besagten Nodes zu 50 %
transparent, sprich die Ausgabe ist wieder
eine Liste. Solche Kleinigkeiten im Interface
der Animation Nodes sind unauffallig, aber
duBerst hilfreich, und zeigen, dass sich der
Entwickler viele Gedanken Uber Usability
gemacht hat.
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Zufall: Das Beispiel
aus dem Artikel lasst
sich weiterspinnen -
man kann die Falloffs
namlich mischen, mit
ein wenig Zufall ad-
diert ist das Beispiel
entstanden.

Matrizen sind einfach besser

Warum verwenden wir den Object Matrix
Output Node statt des Object Transform
Output Nodes wie im Coin-Stack-Beispiel
des letzten Animation-Nodes-Artikels? Nun,
Matrizen kodieren gleich drei Transformati-
onen auf einmal, ndmlich Translation, Rota-
tion und Skalierung. Wir sparen uns dadurch
ein paar Nodes, was auch der Ubersicht zu-
gutekommt. Und wir kénnen einen Node
einsetzen, der die bendtigten Matrizen direkt
aus einer Liste von Vertices und Normalen
ausliest: Distribute Matrices (Shift+A > Matrix
> Distribute).

Den Ausgang des Distribute Matrices
Nodes verbinden wir mit dem Matrix-Ein-
gang des Object Matrix Output Nodes und
mit dem Instances-Eingang des Object In-
stancer Nodes. Dabei fUgt Animation Nodes
automatisch einen Get List Length Node als
Konverter zwischen. Die Anzahl der Wurfel-
Duplikate ist jetzt immer gleich der Anzahl
der Matrizen aus dem Distribute Matrices
Node.

Im Dropdown-Men0 des Distribute Matri-
ces Nodes wahlen wir ,Vertices". Als Eingan-
ge habe wir nun eine Liste von Vertices und

eine Liste von Normalen. Diese kénnen wir
Uber einen Object Mesh Data Node bezie-
hen (Shift+A > Mesh > Object Mesh Data).
Dort setzen wir die Icosphere als Quelle und
verbinden den Vertices-Ausgang mit dem
Vertices-Eingang des Distribute Matrices
Nodes. An dieser Stelle sollten die Dupli-
kate des Wurfels erscheinen, allerdings sieht
das Ganze noch nicht aus wie gewiUnscht,
da die Wurfel zum einen viel zu gro3 und
zum anderen alle gleich rotiert sind. Dadurch
entsteht eine Art WUrfel mit abgerundeten
Kanten anstatt der gewunschten Kugel aus
Waorfeln.

Gut versteckt

Die GroéBe der Wurfel kénnen wir sehr gut
kontrollieren, indem wir den urspringlichen
Woarfel im Edit Mode skalieren. Die Ausrich-
tung erreichen wir Uber die Vertex Normals.
Deren Ausgang ist beim Object Mesh Data
Node standardmaBig versteckt. Wenn wir
den Node anwahlen, sehen wir rechts im
Properties Panel die Inputs und Outputs.
Die Liste der moglichen Ausgabe-Sockets
ist ziemlich lang - verstandlich, dass stan-
dardmaBig nicht alle davon sichtbar sind. Ein
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Klick auf das Augen-Symbol Vertex Normals
|8sst den entsprechenden Ausgang erschei-
nen, und wir kénnen ihn mit dem Normals-
Eingang des Distribute Matrices Nodes ver-
binden. Jetzt sind alle Wurfel entsprechend
der Vertex-Normalen ausgerichtet, sprich sie
zeigen von der Oberfldche der Kugel weg.

Schiebung

Jetzt ist der Punkt erreicht, an dem die
Falloffs ins Spiel kommen. Falloffs konnen
in Animation Nodes nicht mit jedem Node
eingesetzt werden, sondern nur mit den-
jenigen, die die entsprechenden grUnen
Eingdnge mitbringen. Ein solcher Node ist
der Offset Matrix Node (Shift+A > Matrix >
Offset). Indem wir ihn Uber die bestehen-
de Verbindung zwischen Distribute Matrices
und Object Matrix Output ziehen, schaltet
sie sich automatisch dazwischen.

Im rohen Zustand ist dieser Node reich-
lich unscheinbar. Erst wenn man im oberen
Bereich die Transformationen aktivert, die
man manipulieren will, zeigt sich sein Funk-
tionsumfang. Wir selektieren sowohl Loc,
Rot als auch Scale, und es erscheinen die
entsprechenden Eingdnge. Wenn man jetzt
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einen Wert verdndert, wird diese Anderung auf alle Wurfel
auf einmal Ubertragen.

Die Grundidee des Beispiel-Effekts ist ein Ausgangs- und
ein Endzustand, zwischen denen mittels Falloff interpoliert
wird. Den Endzustand haben wir bereits in Form der Wurfel-
Kugel, die wir gebaut haben. Den Ausgangszustand definieren
wir jetzt in diesem Node. FUr das Beispiel ist das eine Scale
von 2,2 auf allen Achsen, eine Rotation von 173 Grad auf allen
Achsen und eine Translation von 0,5 auf der X-Achse.

Besser versteckt

Die Translation passiert standardmafig allerdings global. Auch
hier bietet Animation Nodes mal wieder eine versteckte Op-
tion. Mit selektiertem Node finden sich im Properties Panel
ganz unten die Advanced Node Settings, wo wir die Transla-
tion auf ,Local Axis" umstellen.

Im Allgemeinen lohnt es sich, bei jedem Node nachzu-
sehen, ob es nicht erweiterte Einstellungen gibt. Das geht
besonders einfach mit der Taste ,U". Und natdrlich sollte man
immer die offizielle Dokumentation zu Rate ziehen (http://
animation-nodes-manual.readthedocs.io/en/latest/).

Herabfallen

Falloffs sind in Animation Nodes ein eigener Datentyp, der
die neuen grunen Sockets verwendet. NatUrlich gibt es dafur
auch eine Reihe an Nodes. FUr unser Beispiel ist der Object
Controller Falloff gut geeignet, weil sich dieser Uber ein Ob-
jekt kontrollieren 13sst (Shift+A > Falloff > Object Controller).
Als Objekt fur den Controller fugen wir ein Empty zur Szene
hinzu. Damit es spéter durch die Wurfel-Kugel sichtbar ist,
vergréBern wir die Display Size des Empties auf 2. AuBerdem
setzen wir es als Objekt in den Object Controller Falloff Node
und verbinden die beiden grUnen Sockets.

Wenn wir jetzt das Empty in die Ndhe der Wurfel-Kugel
bewegen, sehen wir schon einen Effekt. Es ist aber noch nicht
ganz das, was erwUnscht ist, denn der Falloff Type ist noch
auf ,Sphere" eingestellt. Ein Wechsel auf ,Directional® zeigt
einen Effekt, der ndher am gewUnschten Ergebnis ist. Jetzt
funktioniert der Falloff nicht mehr punktférmig vom Zentrum
des Empties aus, sondern von einer unendlich groBen, un-
sichtbaren Fldche. Je nach Richtung, in die das Emtpy spater
bewegt wird, sollte allerdings noch die Achse geandert wer-
den. FUr eine Bewegung von Links nach Rechts entlang der
X-Achse z.B. auf ,-X".

Hier eroéffnet sich eine Reihe von Mdglichkeiten. Z.B. kén-
nen wir die Breite des Falloffs direkt kontrollieren, indem wir
das Emtpy gréBer oder kleiner skalieren. Wie der Ubergang im
Detail aussieht, 13sst sich Uber die Interpolation regeln. Hier
kénnen wir entweder eines der viele Presets wie z.B. quadra-
tisch wahlen oder die Interpolation véllig frei Uber eine Kurve
definieren (Shift+A > Interpolation > From Curve). >ei

Gottfried Hofmann ist Diplom-Informati-
ker und bietet seit mehreren Jahren pro-
fessionellen Support sowie Schulungen
fur die freie 3D-Software Blender an.

Als freischaffender Autor schreibt er fur
Fach- und Computerzeitschriften. Er hat
zahlreiche Blender-Tutorials verfasst, u.a.
for CG Tuts+und CG Cookie. Weiterhin
betreibt er die Webseite www.Blender-
Diplom.com, auf der Blender-Tutorials

in deutscher und englischer Sprache zur
Verfigung stehen und Schulungen ge-
bucht werden konnen.
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